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Now that you have installed TTS, you are ready to begin using the system. This brief Quick Start
Overview and the following User’s Manual provide the general information needed to begin entering
data into the system and start using TTS for the first time.

TOOL CLASSIFICATIONS, TYPES, USER DEFINED FIELDS, AND MAINTENANCE

This function allows you to create classifications and types. Classifications (i.e. Power Hand Tools) and
their (sub-) Types (i.e. Drills, Saws, etc.) are used to categorize tools within the system. On the menu
bar select Support=>Tool Support Administration. You can rename the Class and Types designators in
the system’s “Setup Options” function if desired. See Tool Support Administration in this Manual for
more information.

CONDITIONS

This allows you to add any number of tool conditions that you desire (Excellent, Good, Poor, Needs
Repair, etc.) This is a searchable field and can be invaluable to locate equipment based upon their
current condition. See the section on Condition Administration for more information.

FUNDING SOURCE AND ACCOUNTS

Funding Source is a standalone field that can be set up to use as needed. The Accounts screen allows
you to tie each tool to an account number for added filtering. You can also rename the Funding Source

and Account in the system’s “Setup Options” function, if desired. See Funding Source Administration
and Account Administration for more information.

MANUFACTURERS

The Manufacturer is a standalone field that can be set up to help filter on equipment by manufacturer.
See Manufacturer Administration for more information.

FACILITIES

This function allows you to enter facilities, which are used to organize tool locations. On the menu bar
select Support—> Facility Administration. See Facility Administration in this Manual for a detailed
explanation.

LOCATIONS

This function allows the user to create locations where tools are stored or to which tools are checked
out. Locations can be classified as “Storage,” “Check Out/Usage,” or “Transfer” locations and are always
tied to facilities. Storage locations are typically where materials are centrally located until checkout. On
the menu bar select Support—>Location Administration. See Location Administration in this Manual for
a detailed explanation.
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EMPLOYEES

This function allows you to create users in TTS. A user may be an individual that will be using the TTS
system, or a person to which tools may be checked out. You can also set TTS Access Rights for each
user. On the menu bar select File>Employee Administration. See Employee Administration in this
Manual for a detailed explanation. NOTE: The user must be logged in as “Admin” to access this option.

PRINTER ASSIGNMENT

This function allows the user to specify which windows printer will be used for report printing, and
which one will be used for label printing. This function must be set on each workstation before printing.
On the menu bar select File—> Printer Assignment. See Printer Assignment in this Manual for a detailed
explanation.

LABEL DESIGN

The system allows the user to design labels for tools, locations, and employees. These labels typically
have barcodes and can be used to audit, check in, and check out tools. Several sample label designs are
included and can be modified. You must select a DEFAULT label design before printing is allowed. On
the menu bar select Labels [ Label Designer. See Label Designer in this Manual for a detailed
explanation.

TOOLS AND MASTER

The tool administration screen allows for the creation of tools which are tracked by this system. On the
main button bar select the Tools button. The Master function is used to enter in common tools in a
master data set that can be selected when adding tools — saving time and effort. See Tool Management
in this Manual for a detailed explanation.

Once you have set up your initial data, you are ready to start using TTS. Check out tools to employees
or locations and create reservations. You can also check tools back “in” to storage. Be diligent on how
you use the system, and it will provide years of reliable tracking of all of your tools!

Backup your database daily!
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LogIn

Upon opening the program, the screen at left will appear. You will

Log In

Enter your user name and password to log in.

User Name: |

Password: |

PRSI

be prompted to enter a User Name and Password. If it is the first
time logging in, you will use the Admin User’s data:

Username: ADMIN
Password: ADMINUSER

Other users may be added to the system after setup. After users
are entered into the system, they should each log in under their

own User Name and Password.

Registration

After logging in as Admin, click File on the menu and select

Registered Owner License

Customer IDENT:
License Key: ‘ | | ‘
\ Clear ‘ \ Register ‘ \ Cancel I

Registration Form. This step is important because it assigns
licensing rights to you. Entering the information will unlock the
program for your licensed use.

The Four Digit Customer Identifier and the 16 digit License Key will
be provided by Gigatrak when the product is purchased.

After registering your product, click File on the menu and select Setup Options. (Setup Options can only
be accessed when logged in as Admin.)

[ Setup Options

==

Setup Options
Edition

@ Basic  Pro { Contractor

Tool Setup (F1)

Rename Classification: ’W
Rename Type: ’Type—

Rename Facility: ’Fac\hty—
Rename Location: ’m:atmn—
Rename Funding Source: W
Rename Model Number: ’W
Rename Serial Number: ’W
Rename Account: ’Accuunl—
Rename Condition: ’W
Rename Master: ’Catalug—

Root Image Folder: ’W}'MR\DMD

Root Document Folder: ’7D
Custom Report Folder: ’7D
gi]aiue‘a Report Logo: ’7D

R Miccell Miscellaneous

& o This option can be used to change
the names of the parameters to
Application Settings (F2)

fit your needs. This makes up the

Rename Asset Number: |Asset Number structure Of the SyStem .
Rename Container: |Container

Classification, Type, Facility,
Location, and Funding Source are
parameters tied to tools. Model
Number, Serial Number, Account,
Condition, Master, Miscellaneous,

Report Auto E-mail Setup

SMIPHost [

From E-mail Address: [
SMTP User Name: [
SMTP Password: [

Use SSL/TLS: [

Asset Number, and Container can
be renamed to suit your needs.
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If you would like to alter any of the names, type in the desired value and then click the OK button.

The root image folder is the default location for images that you wish to tie to a tool. If the image is in

the default location, only the file name is required in the tool screen to identify the image.

The Custom Report Folder is the location for custom report files. If a custom report is ordered, the

report file should be placed in a folder, and the path to the folder should be set in this option.

The Report Logo allows the display of a company logo on reports. You can select a .bmp, .gif, or .jpg file.

To clear a logo after it is selected, click the “Select” button and click Cancel on the selection screen.

[ Setup Options

=g

Edition

I” Show Depreciation

I Allow Delete Tool & Purge Tool History

I Auto-populate Tool Find tab

I~ Cascade Master changes to Tools

I Auto-generate Tool Barcode if left blank

I Display Employee Barcodes before names

I Display Account Numbers before descriptions

¥ Show Bin Tools Below Reorder Point Report after Log in
I Require Check In before another Check Out

I~ Show Transfer

I Allow users to change their password

Allow duplicate Asset Numbers (if allowed, Asset Number
cannot be used for check out / check in)

Setup Options

@ Basic  Pro ¢ Contractor

Tool Setup (F1)

[v Auto Commit Downloaded Data upon Sync

o o

Application Settings (F2)

Preferred Depreciation Type: |[one

Log In Password Settings

[~ Enforce Password Policy

Maximum Length of passwords = 10 characters

Minimum number of characters

Minimum number of lower case characters

Number of attempts before lockout (inactivates user)
(Blank or zero allows unlimited attempts)

(MACRS: Modified Accelerated Cost Recovery System)

Minimum number of upper case characters

Minimum number of numeric characters

Minimum number of symbols

5

AT

['% Setup Optionsf?

Setup Opq

Edition
& Basic

|

¥ Show Di
I Allow Dy
v Auto-poj
" Cascad
[~ Auto-gel
™ Display
™ Display

¥ Show B
™ Require
[~ Show Tr
[~ Allow ug

Allow dul
cannot g

& Depreciation Disclaimer

Depreciation Disclaimer

[This Depreciation Function, including access to formulas used for the computations provided
herein, is provided by GigaTrak solely for your convenience and for illustration purposes only.
GigaTrak is not licensed or qualified to give. and is not providing to you, any legal, tax,
financial reporting or accounting advice. GigaTrak does not guaranty the accuracy of

the computations. Furthermore, GigaTrak can not be aware of any customer's particular
circumstances and GigaTrak does not purport to keep up to date with any tax, financial
reporting or accounting standards or requirements. The information contained herein is

not guaranteed to be correct, complete or up to date. Accordingly, you should consult

with your own legal, tax, financial reporting and accounting advisors. GigaTrak is

not responsible for any loss, injury, claim, liability or damage related to your use of this
Depreciation Function or the output hereof and by your use of this Depreciation Function
'you waive and release GigaTrak from any such loss, injury, claim, liability or damage.

'You use this Depreciation Function at your own risk and the correctness and usability

of the output hereof remains your sole responsibility.

GigaTrak is not licensed or qualified to give, and is not providing to you, any legal, tax,
financial reporting or accounting advice.

" | agree to the terms of this disclaimer

| do not agree to the terms of this disclaimer

very System)

ARRRBR

(Blank or zero allows unlimited attempts)

Application Settings control various
functions in the tool tracking
application.

If Show Depreciation is checked,
then the depreciation information
will be visible on the Tool
information screen. The Tool
Depreciation Report will also be
available on the Reports screen. If
the checkbox is not checked, the
depreciation information will not
be visible and the depreciation
report will not be shown.

The checkbox cannot be checked
until you accept the disclaimer.

After accepting the disclaimer, the
Preferred Depreciation Type
selection will be enabled. This will
be the default selection when
adding new tools on the Tool
Information screen.
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ALLOW DELETE TOOL & PURGE HISTORY

If checked, then the Delete button will be displayed on the Tool screen, and the Purge History button
will be displayed on the Tool History screen. If the checkbox is not checked, the Delete button and the
Purge buttons will not be displayed.

AUTO-POPULATE TOOL FIND TABS

When checked, the system will automatically display information when a Find screen is opened. If not
checked, you must first click “Extract Data” to view a listing.

CASCADE MASTER CHANGES TO TOOLS

This selection gives you the option to push any changes from the Master Catalog function to each
respective Tool assigned to the Master Number. CAUTION: Changes to the Master Catalog may RESET
User-Defined data to the values set within the Master Catalog.

AUTO-GENERATE TOOL BARCODE

This option creates a new barcode ID when adding new tools IF NO BARCODE is assigned. Use this
option if you intend to design and print your own barcodes. If you have chosen to use pre-printed
barcodes or are switching from an existing system do not select this option.

DISPLAY EMPLOYEE BARCODES BEFORE NAMES

This applies to several report selection filters. If you view employees primarily by their names, leave
this unchecked. If you prefer tracking employees by the Barcode ID, then check the checkbox.

DISPLAY ACCOUNT NUMBERS BEFORE DESCRIPTIONS

The same rules apply to this option. Select how you prefer to view your report filters here. If you will
view accounts by descriptions, leave this unchecked. If you prefer tracking accounts by numbers, check
the box.

SHOW BIN TOOLS BELOW REORDER POINT REPORT AFTER LOG IN

By selecting this option, the system will automatically display the report of any binned items below the
reorder point immediately following log in.

REQUIRE CHECK IN BEFORE ANOTHER CHECK OUT

Checking this box will require a checked out tool to be checked back in to the storage location before it
can be checked out again. Leaving this unchecked will allow a tool to be checked out from person to
person (or location to location) without being returned to the storage location.

SHOW TRANSFER

This option can be activated if you would relocate tools from one Facility/Location to another. Once
you check this and click the OK button, the Transfer tab will appear on the toolbar.
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ALLOW USERS TO CHANGE THEIR PASSWORD

Selecting this option will give access for users within the system to change their own password. If not
selected, the Admin will be the only one with authority to create or change a password for a specific
user.

ALLOW DUPLICATE ASSET NUMBERS

The Allow duplicate Asset Numbers gives the option to have multiple of the same Asset Numbers, but if
selected, the Asset Number field cannot be used for check out/check in of a tool.

AUTO COMMIT DOWNLOADED DATA UPON SYNC

If checked, this option will result in the data from the handheld being automatically committed to the
PC database upon docking the handheld. If unchecked, the process to sync & commit data will be
“Sync” > “Commit” > “Sync”.

On the right side of the Application Settings box, there is an area for Log In Password Settings. You can
choose to Enforce Password Policy, by choosing a Minimum number of characters, Miminimum
number of upper case characters, Minimum number of lower case characters, Minimum number of
numeric characters, Minimum number of symbols, and Number of attempts before lockout (inactivates
users).

To save the changes for both tabs on the screen, select the OK button. A confirmation message will
appear, listing the items that you altered. Selecting “Yes” will save the changes and close the screen.
Selecting “No” will reset the changes back to the original values.

To leave the screen without changing any values, select the in the upper right corner of the
screen.

The printer assignment process is used to set the printer the system will use for printing reports and
barcode labels. Select Printer Assignment from the File menu and the screen below will be displayed.

£% Printer Assignment || The Available Printers list will display all the

Printer Assignment printers that are on the Windows printer list.

Available Printers

To select the report printer, select the printer of

Mot Available -

Send To Onellote 2013 choice and then click the Assign Default Printer
Microsoft XPS Document Wrter : button. The Default Printer label will indicate
WPTS3\Brother HL-2170W series . :

HP Color LaserJet Pro MED MA76 PCL 6 i the printer you selected. Any reports printed by

the system will be directed to this printer. This

r_,_.%f Assign Default Printer r_,_%f Assign Label Printer

does not affect the windows default printer
Default Printer: WPTS3\Brother HL-2170W series selection.

Label Printer: WPTS3\Brother HL-2170WV series
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To select the label printer, select the printer of choice and then click the Assign Label Printer button.
The Label Printer label will indicate the printer you selected. Any labels printed by the system will be
directed to this printer. If you do not have a label printer, assign the default printer to act as the label
printer.

Employees are either people that have access to the TTS system or people whom tools will be assigned.
To manage employees, select Employee Administration under the File menu.

B Employee Adminitatiy = Upon initial setup, the only employee
Employee Administration will be the Admin user. You may Add,
(4 paa| [/ ea| [§ velee] Edit, or Delete employee
Employee: ’7 \ > Export To File ID Print Barcode List Print Label ‘ |nf0rmat|0n
N Barcod Facility Active?
Bty i s e e | To Add a new employee, select the
Doe, Mary E002 ACME Administration Yes .
Jones, Mike E346 ACME Central Warshouse Yes Add button The form W||| Cha nge as
Smith, John E001 All Yes A X ) .
User, Adin ADMIN Al Ves indicated. The items in bold text are

required for all employees.

The system will not allow editing of
the last name, first name, middle
initial, or user name for Admin User.

To delete an employee, select the

employee and then select the delete
button.

5 rows found

If an employee is assigned a tool or has an outstanding reservation or is involved in a history record,
the system will not allow the employee to be deleted. Set the Status to inactive to prevent further use.

To print employee labels, select the employee(s) to be printed and then select the Print Label button.
If a label printer has been selected and if a default employee label has been designated (see Label
Designer in this manual), the label(s) will be printed.

For label printing, multiple employees may be selected. To select multiple employees, do one of the
following:

e Dragthe mouse over the employees desired while holding down the left mouse button.

e Select the first employee by left clicking with the mouse. Select the last employee in a range
by holding down the Shift key and the left clicking on the last employee. All employees in
between will be selected.

e Hold down the Control (Ctrl) key and select the employees you wish to print by left clicking
on each one with the mouse.
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Enter the appropriate employee information. A few fields have special requirements:

-, pm— -
%, Employee Administration

The barcode entry must be unique. A barcode for a tool,

Employee Administration

Employee Info

rﬂ Save

Firshlame: |

Last Name: |

Middle Initial:

Barcode: |

Log in Mame:

(Min. 5 characters}

Passwaord:

(Min. 5 characters)

Phone: |

Alt. Phone: |

E-mail: |

Notes:

location, or employee cannot be the same. Keep the barcode
as simple as possible, only using a short combination of
capital letters and numbers. If you use the supplied barcode
labels, the employee's barcode must match the label placed
on their badge.

If the employee will be using the TTS system, he will require a
Log in Name and Password.

The Log in Name must be between 5 and 10 characters long.
It must be unique; no two employees may have the same log
in name. Log in names are not case sensitive.

A password must be between 5 and 10 characters long.
Passwords are not case sensitive.

EMPLOYEE ACCESS LEVELS

Once the employee information is entered, set the employee's access levels. The default access level is

for no access to TTS.

¢ Employee Administration

=1 Master (or Catalog) — applies to activities

Employee Administration

‘H Save ‘

‘@ Cancel ‘

Employee Info

Firshilame:

Middle Initial

Alt. Phone:

E-mail

Last Name:

Barcode:

Phone:

Notes:

Access Levels

Access Levels

Catalog
@ No € View

Tools
®No  View

Check IniOut
@ No ¢ Simple

Transfer
@ No

Reserve
@ No ¢ View

© Edit

" Edit

" Edit

" Edit

 Edit

associated with creating and editing master data.

Assigned Facility

Employee Administration
@No CView CEdt

Tool Status Administration
& No " Edit

Support Administration
FNo ¢ View ( Edit

Tools - applies to activities associated with
creating and editing tool data.

Check In/Out — applies to activities associated
with assigning tools to an individual or location,
or returning tools to storage.

Transfer — applies to activities associated with
transferring tools to facilities.

Reserve — applies to activities associated with creating and editing tool reservations.

Employee Administration — applies to activities associated with managing employee information.

Tool Status Administration — applies to activities associated with editing tool status.
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Support Administration — applies to activities that support the overall tool process. This will include
managing facilities, locations, tool types, classifications, and conditions.

EMPLOYEE ASSIGNED FACILITY

If you have multiple Locations/Facilities, you can select which ones an employee can check out/check in
tools from. You can check “All Facility(s)” to allow access to them all, or you can select individual

facilities.
é“" —| Change the information or access levels as
mployee Administration
(@ see | (@ cancel] required and then select the Save button to
SmmSSIS Peonsa Lok e save the changes, or the Cancel button to
st Name: Assigned Facility
s e — R Al Fciy) leave the Edit process without saving.
Bmm: Chk | Facility
ii ACME Administration .

ELM S If the user logged into the system only has
Phone: H 1 H
e view rights to employees, the Add, Edit,

e —— and Delete buttons will not be available.
- Instead, a View button will be available to
allow the user to look at but not change
employee information.

If you have the Access version of TTS, this option is used to periodically repair, compact, and backup the
TTS database. To determine if you have the Access version of TTS, go to the Help tab=>About and the
header of the box will say “About (Access)”

It is possible that the Access database can get corrupted. Compacting the database may repair the
damage. In addition, a previous compact operation will have created a backup of the database that can
be used if the current database is corrupted beyond repair.

The system will retain three backup copies of the database in the dbbackup folder. Backing up
frequently will minimize the loss of data if the current database is corrupted beyond repair.

H%ackupﬁ Compact Database =
Backup | Compact Database MS Access does not automatically remove data that is

Thi: d ill i datab; I d o .
overall database size by romoving delotod and duplicate records. deleted by the system. Compacting the database will
It will also create a backup copy of the current database in the
'dbbackup’ folder. remove data that has been deleted. This will reduce the
Th ill ki he last 3 backs i f the database. . . .
The ovdest ile will be deleted, T o AAnase size of the database file and improve performance.

To repair/compact the database, click the Compact Database button.

To compact the database, select Compact Database

under the File menu. Then select the Compact Database
button.
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The system will compact, repair, and backup the database and when complete, the Compact Database
screen will disappear.

e =1 Auser currently logged into TTS may change their password at
Change Password],, any time. Select Change Password from the File menu and the
Enter current User Name and Password. screen at |eft appears

Then follow the on-screen instructions.

User Name:
Password:

Change Password

Type in your current user name and password and then select the
Change password button.

Passwords must be between 5 and 10 characters long.

Type in your new password and then select the Change Password button.

il Change Password

Type in your new password again. If the password matches the new
password you typed earlier, the system will save the new password Enorcutet User Name and Poseword.
and the Change Password screen will disappear. fhen follow the on-screen instructions.

Change Password

If the password does not match the password typed in earlier, the
system will state the passwords do not match and ask if you wish to

ty again.

If you answer yes, the screen will be returned to the state above and
you may try to type the second password again.

Enter New Password:

£ Logn Temparariy % Log in temporarily is a function used in order to perform

e———m— some function that the current user may not complete
without the current user having to exit the program.

Enter your user name and password to temporarily login.

User Name: | Select Log In Temporarily under the file menu. The screen at
Password: right will appear. Enter your user name and password, and
then select the Log In button.
g Login The banner on the main screen will turn red. As long as

someone is temporarily logged into the system these
conditions will remain.

When the user temporarily logged in logs out by selecting the Log Out button, the main screen will
return to normal and the original user is the current user.
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PURGE HISTORY

nter Date Bg
If you would like to purge all history before a certain date, you can e’
Al tool history records prior bo this date will be purged.
enter a specific date and then click OK. WARNING!! Be very careful Plesse enter  date %
with this feature, when you click OK, all tool history records will be
purged for good.
HANDHELD CONFIGURATION
@ Handheld Configuration % The Handheld Configuration screen is used

to select the handheld device. This version

Handheld Configuration of TTS currently supports Windows Pocket

(Other) PC and CE handhelds.
Datalogic Memar

Datalogic Skarpio . . .
Honevwell Dolohin 6100 To view the Handheld Configuration

Intermec CK71 and CMN70 screen, click the File menu item and select
LXE MX8 Handheld Configuration.

Pocket PC devices require Microsoft

ActiveSync (for Windows XP) or Windows
Handheld Data Folder: |1Honeywe|l‘m . . . .
Mobile Device Center (for Windows Vista

or Windows 7) to communicate with TTS.

Further instruction on how to use the Handheld device and configuring it with the Tool Tracking
System will be discussed later.

IMPORTS

[ Import Employees 2 Each import has specific instructions included on
the import screen that delineates data formatting
requirements along with any special instructions

Import Employees

This import[xg for NEW employees only. o .
It does NOT update existing employee records. you may need. Imports are available for the

The column layout of the expected import file is as follows: following:

*Mame, *Barcode, *Facility, Log in Name, Password, Phone, Alt. Phone,

E-mail, Notes, Master Access, Tool Access, Check In / Out Access, . .
Transfer Access, Resenvation Access, Member Access, Employee Access, Import Accounts: Allows the import of account

Tool Status Access, Support Access, Maintenance Access, Status data into the Account Administration table

- The file format is TXT (Tab delimited).
- The layout will be based on column position, not column headers.

- Acolumn header row, if detected (based on the words BAR CODE or Import Employees: Allows the import of emp|0yee
data into the Employee Administration table. The

import even allows for the granting of specific

5
[J FindFile access rights to the various functions in TTS.

1 Backup the database R .
. View —= /3 (File menu) before Import Funding Sources: Allows the import of

& Log File i importing new data

funding source data into the Funding Source

Administration table.
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Import from ToolWatch®: ToolWatch® is a product of ToolWatch Corporation and licensed and
copyrighted specifically for their own purpose. As with any software product, you the user have specific
rights to your own data. We at GigaTrak have been requested to accept data from ToolWatch® so an
import for specific data is made available. You must be careful when moving data from one system to
another and make sure that all procedures are followed to avoid data problems. Contact GigaTrak for
additional information.

Import Locations: Allows the import of location data into the Location Administration function. Careful
— Locations are Facility Specific so the data must be accurate.

Import Master/Catalog Items: Allows the import of master/catalog data from outside sources.
Additional data may be desired but requires user editing after the import is completed.

Import Tools: If you have spent years managing your inventory in an Excel formatted file, this can help
you save time by importing your existing tool inventory quickly and safely. It is critical to ensure that
the data is accurate and formatted properly to avoid bad data upon import!

The Label Designer process is used to design labels for the various processes in the system that prints
barcode labels.

Label Designer (|

The processes that will print labels are:

Label Designer

Design Type Current Label Designs [ TOO | S

F‘EMD\OYee, . . .

[ oson et B e Employee Administration
e e Location Administration

Element Options.

fT-|1[o/@ These processes can be selected in the

Adial - 12 - Regular

Design Type section of the form, which

I” Wrap Text? [ Center Text?

is located in the upper left corner.

Label Size

Aa Font Width ~ Height
o T || (L To design a label, first select the design
‘ m 2rienla|ion Mode
CPost | egn veu) || Type.
‘ New ‘ ‘ 5 Delete | ‘ [ﬂ Save ‘ ‘ [ﬁ' Save Design ‘ P
—  Design Design Design As Label Printer ZDesigner TLP 2844

Vo4

The Data Source List will contain the possible fields that may be included in the label. The list on the
example contains the possible data sources for an Employee label.

The Current Label Designs list will contain any labels that have already been created for the design type.
The list currently contains a sample employee label. When one of these labels is selected, the box on
the right will display the label design, as indicated above for the sample employee label.

To create a new label, select the Design type and then select New Design button. Set the label size
(Width and Height in inches). Set the label orientation (Portrait or Landscape). For Portrait, the height
is vertical on the screen. For Landscape the Height is Horizontal on the screen.

TTS USER MANUAL- BASIC EDITION 18



There are 6 different elements that may be placed on the label. They are from left to right: text,
barcode, horizontal line, vertical line, box, and a graphic.

ADDING A TEXT ELEMENT

Select the Text button in the Element Options panel. Select (Label Caption only) in the Data Source box,
and type a label caption in the Label Caption textbox. You can select Wrap Text or Center. To set the
font style and size, click the Font button. Click the Add to Label button. The text element will appear in
the upper left corner of the label design. Drag it to the desired position on the label.

To edit the text caption or font after a text element has been placed in a label design, right click on the
element and choose the option desired.

ADDING A DATABASE FIELD TEXT ELEMENT

In the Data Source box, select the desired database field. You can select Wrap Text or Center. To set
the font style and size, click the Font button. Click the Add to Label button. A sample of the data will
appear in the upper left corner of the label design. Drag it to the desired position on the label. When
the label is printed, the actual data for that field will be printed on the label.

To edit the text caption or font after a database field text element has been placed in a label design,
right click on the element and choose the option desired.

ADDING A BARCODE ELEMENT

Select the Barcode button in the Element Options panel. Select (Label Caption only) in the Data Source
box, and type a label caption in the Label Caption textbox. You can select Center. Select the barcode
font and size desired. Click the Add to Label button. The text will be added to the label in the barcode
font. Drag it to the desired position on the label.

If a database field is needed as a barcode, select the field from the Data Source box, and add it to the
label. When the label is printed, the actual data for that field will be printed on the label as a barcode.

ADDING A HORIZONTAL LINE ELEMENT

Select the Horizontal Line button in the Element Options panel. Click the Add to Label button. A
horizontal line segment will be added to the label design in the upper left-hand corner. Drag it to the
desired position on the label. To change the size of the line, place the mouse cursor over the right end
of the line. When the cursor changes to a double arrow, click and drag the endpoint to the desired
length.

ADDING A VERTICAL LINE ELEMENT

Select the Vertical Line button in the Element Options panel. Click the Add to Label button. A vertical
line segment will be added to the label design in the upper left-hand corner of the label. Drag it to the
desired position on the label. To change the size of the line, place the mouse cursor over the bottom of
the line. When the cursor changes to a double arrow, click and drag the endpoint to the desired length.

TTS USER MANUAL- BASIC EDITION 19



ADDING A BOX ELEMENT

Select the Box button in the Element Options panel. Click the Add to Label button. A box will be added
to the label design in the upper left-hand corner. Drag it to the desired position on the label. To
change the size of the box, place the mouse cursor over the lower right-hand corner of the box. When
the cursor changes to a double arrow, click and drag the endpoint to the desired size.

ADDING A GRAPHIC ELEMENT

Select the Graphic button in the Element Options panel. Click the Find Graphic File button to find a file
on your computer to place on the label. File types supported are bmp, gif, jpg, wmf, and ico. Click the
Add to Label button. The graphic will be added to the label design in the upper left-hand corner. Drag
it to the desired position on the label.

Graphic elements are resizable. Save the label design before attempting to resize a graphic element.
Right click on the graphic in the label and select Resize Graphic. A Resize Graphic box will appear above
the Label Size box. Enter the desired Height and Width (in inches) and click the OK button. It may be
possible to enter a size that causes the graphic to disappear from the label design. If this happens,
select a different label design. When prompted to save changes, respond NO to the prompt. Then go
back to the label design and try again.

DELETING A LABEL ELEMENT

Select the element to be deleted from the label design. Click the Delete Element button, or press the
Delete key on the keyboard. Elements can also be deleted by right-clicking on the element and
selecting Delete from the popup menu.

DELETING A LABEL DESIGN

To delete an entire label design, select the design from the Current Label Designs list. Click the Delete
Design button at the bottom of the screen.

SAVE AN EXISTING DESIGN AS A NEW DESIGN

Time may be saved by copying an existing label design and modifying it. Select the design from the
Current Label Designs list, and click the Save Design As button at the bottom of the screen. Enter a new
design name and click the OK button. Design names must be unique.

VIEWING/PRINTING A LABEL

The work space on the right-hand side of the screen provides a feel for how your label will print. If you
need to view exactly how your label will print, click on the View button with the Mode setting set to
Design. An exact replica of the label will appear. To print the label on your label printer, change the
Mode setting to Print, enter the number of labels you want to print and click the Print button.
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SAVE AS DEFAULT

To save a label design as default for a specified process, select the Design Type (process), and select the
label design from the Current Label Designs list. Then select the Save as Default button.

When a label is set as the default label, the word "Default" will appear after the label design.

To put the tool barcode on your label as a barcode:
a. In “Element Options” select the barcode button.
b. Inthe “Data Source” list box, select “Tool Barcode”.
c. Click the “Add to Label” button to put it in your label design.
d. Dragthe element to the desired position.

To put the tool barcode on your label as a text field:
1) In “Element Options” select the “T” button.
In the “Data Source” list box, select “Tool Barcode”.
) Set the desired Font options.
Click the “Add to Label” button to put it in your label design.
Drag the element to the desired position.

u b~ WN
-— = —

After logging in, select Check for Update on the Help menu. Major updates may require you to contact
GigaTrak and receive a special download. Access to the Check for Update function is only available
when the ADMIN login is used. You must have a current Support Agreement in place to download

updates.
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ACCOUNT ADMINISTRATION

Account Administration is used to keep track of the account numbers that are used to purchase tools.

Account numbers are not required to use TTS.

€= Account Administration =N
Account Administration
Add Edit % Delet
I g 2 | [ e ] K o
Account Number: |1EIDEIEI
Description: |Engineering Department
o) @)

Account Number Description Active?

10000 Engineering Department

20000 Maintenance Department Yes

30000 Administrative Department Yes

To begin the process, select Account
Administration from the Support
menu.

To Add a new account, select the Add
button. Enter the Account Number
(required field) and a description
(optional), then select the Save button.

To Edit an Account, select the Account
of interest and then select the Edit
button. Modify the information as
desired. Select the Save button to save
the Account changes.

To Delete an Account, select the
Account to be deleted and then select
the Delete button. The system will

check to see if the account is tied to a tool. If so, the system will not allow the Account to be deleted.

You may inactivate the Account to prevent it from being assigned to a tool in the future if you desire.
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Tools may be assigned a Condition, which indicates the usefulness of the tool. To access this process,
select Condition Administration under the Support menu.

Schedule Retire

Yes

ﬁ( Condition Administration \EI
Condition Administration
‘ I%: Add ‘ ‘ // Edit ‘ ‘ % Delete
[
Condition: ‘Excellent
Description |Hear new condition
o r

Condition Description Active?
Good Minimal damage typically cosmetic in nature  Yes
Needs Paint Yes
Needs Repair Tools and Equipment requiring repair Yes
Poor Damage with some functional problems Yes
RMA Yes

Each Condition has a name and Description. In
addition a Condition may be designated as
Active or Inactive.

Condition name may be up to 20 characters and
is required. This name must be unique.

Description may be up to 80 characters long and
is not required

A Condition set as active may be assigned to a
tool; a Condition set as inactive will not be
available for assighnment to a tool. Setting a
condition as “inactive” minimizes clutter, but
retains historical information tied to each
condition.

To add a new Condition, select the “add”
button, enter the new Condition (name) and
Description, and click “save” button to save the
new condition.

To edit an existing Condition, select the Condition to be edited and then select the Edit button. Modify
the Condition (name), Description, or Status (Active vs. Inactive). Select the Save button to save the
changed Condition.

To delete a Condition, select the Condition to be deleted and then select the Delete button. The
system will check to see if the Condition is assigned to a tool. If so, the system will not allow the
Condition to be deleted. You may inactivate the Condition to prevent it from being assigned to future
tools if you desire.
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Facilities are the upper hierarchy of locations. In other words, locations are tied to a facility. Due to
this structure, at least one facility is required by the system.

L Facility Administration [E=l| To begin the process, select Facility Administration from the
Facility Administration Support menu.
l'%ﬂ dd l [/ = l IW Dalate To Add a new facility, select the Add button.
Facility Enter the facility information as desired:
i e Unique Name: Up to 40 characters and is required.
Address: Up to 40 characters, but it is not required.
ACME Warghouse 2 Yes City: Up to 40 characters, but it is not required.
Jensen Repair Yes ey e .
e Yes State: Up to 2 characters, but it is not required.
g:::;fe — ::2 Zip Code: Up to 10 characters, but it is not required.
Stores Yes Notes: Up to 255 characters, but it is not required.
TL345 - Cessna Citation Yes

Select the “Save” button to save the new Facility.

To Edit a Facility, select the Facility of interest and then
select the Edit button. Modify the information as desired.

Select the Save button to save the Facility changes.

To Delete a Facility, select the Facility to be deleted and
then select the Delete button. The system will check to see if a location is tied to the Facility. If so, the
system will not allow the Facility to be deleted. You may inactivate the Facility to prevent a location
from being assigned to it in the future if you desire.

Funding Source Administration is used to keep track of the agency that provided funding for the tool.

Funding Source Administration @

To begin the process, select Funding Source Administration
Funding Source Administration

] (7 ] (Ko

Funding Source

from the Support menu.

To Add a new Funding Source, select the Add button. Enter
the description, then select the Save button.

|Capila| Budget - Maintenance

To Edit a Funding Source, select the Funding Source of
interest and then select the Edit button. Modify the

Description Active? . . R
Capital Budget - Maintenance information as desired. Select the Save button to save the

Operating Budget - Maintenance Yes .
Funding Source changes.

= i

To Delete a Funding Source, select the Funding Source to be
deleted and then select the Delete button. The system will
check to see if the Funding Source is tied to a tool. If so, the
system will not allow the Funding Source to be deleted.
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LOCATION ADMINISTRATION

Location Administration is used to manage the locations to which tools may be assigned. It displays all

the locations that exist in the system that are tied to the facility selected.

= Location Administration ==
Location Administration
Add Edit % Delet
[ e | [ e | [ v
=1 a i e’
[ Export To File I :Sﬂlc"'";l:di?jﬁ‘;:‘s""‘* I () Print Barcode List l I Print Label
Facility: | SRR e -
Location Barcode Responsible Individual Storage? | Transfer? |Active?
los | N0 Yes Ve |
Aisle 1 L005 Yes No Yes
Aisle 2 L006 Yes No Yes
Dock A AWTTR No Yes Yes
Jensen Repair Looa Mo Yes Yes
Shelf 100 Lo03 Yes No Yes
Shelf 200 Lo04 Yes No Yes
Shelf 300 L007 Yes No Mo

To add a new Location,
select the Facility to which it
is to be added and then
select the Add button.

Enter the location
information as desired:

Facility - defaults to the
facility selected on the main
form but may be changed.

Location - may be up to 50
characters and is required.
Must be unique to each
location.

Barcode - may be up to 20 characters long and is required. A barcode for a tool, location, or employee

cannot be the same.

# Location Administration

=

Location Administration

‘ E Save ‘ @Eancel
Eﬁ Add New Facility «E}u Add New Employee

Facility: |ACME Central Warehouse j Respansible Individual: ‘ j

Location: m hotes:

Barcode: 003

(" Checkout/Usage Location

& Storage Location Seat
atus
(" Transfer Location A cl
v Active nactive

Address:

Notes - may be up to 255 characters long and is not required.
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Checkout/Usage Location -
location that tools can be
checked out to.

Storage Location - location
used for storage rather than
usage.

Transfer Location - location
that tools transfer to.

Responsible Individual -
employee that is responsible
for the tools at the location.
This is not required. If the
responsible individual is not
in the system, you may go
directly to the Employee
Administration process by
selecting the Add New
Employee button.
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To edit a Location, select the Facility containing the Location, select the Location of interest and then
select the Edit button. Modify the information as desired. Select the Save button to save the Location
changes.

To delete a Location, select the Location to be deleted and then select the Delete button. The system
will check to see if a tool is tied to the location or the Location is being used in a history record. If so,
the system will not allow the Location to be deleted. You may inactivate the Location to prevent a tool
from being assigned to the Location in the future if you desire.

EXPORT LIST TO FILE

This button will export information for the displayed locations to a tab delimited text file.

CHANGE RESPONSIBLE INDIVIDUAL

Change Responsible Individual will change the responsible individual for all selected locations on the
screen. Display and select the locations that you want to change. To select multiple locations, do one
of the following:

e Dragthe mouse over the locations desired while holding down the left mouse button.

e Select the first location by left clicking with the mouse. Select the last location in a range by
holding down the Shift key and then left clicking on the last location. All locations in between
will be selected.

e Hold down the Control (Ctrl) key and select the locations you wish to change by left clicking on
each one with the mouse.

After the locations are selected, click the Change Responsible Individual button. A screen will appear
where you can select a new Employee. Select the new Employee and click the OK button.

PRINT BARCODE LIST

Print Barcode List will print a list of the displayed location barcodes that can be used for scanning.
When the Print Barcode List button is selected, a pop-up window will appear where you can set the
barcode row height. This allows you to control the space between barcodes on the list. The minimum
row height is 0.5 inch.

PRINT LOCATION LABEL

To print a Location label, select the location(s) to be printed and then select the Print Label button. If a
label printer has been selected and if a default location label has been designated (see Label Designer
in this manual), the label(s) will be printed.

For label printing, multiple locations may be selected. To select multiple locations, do one of the
following:

e Dragthe mouse over the locations desired while holding down the left mouse button.

e Select the first location by left clicking with the mouse. Select the last location in a range by

holding down the Shift key and then left clicking on the last location. All locations in between
will be selected.
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Hold down the Control (Ctrl) key and select the locations you wish to print by left clicking on each one
with the mouse.

Tool Support Administration is used to administer Classifications and Types. Tool Support
Administration screen has two (2) tabs: Classification and Type.

CLASSIFICATION:

[% Tool Support Administration

x|

Tool Support Administration

IE-D..-ZI Add I l‘// Edit I l% Delete

Classification (F1) Type (F2) Classification to organize

Classification: |Hand Powered Tools

The first tab is Classification.

I@ Al “*1] Tools may be assigned a

them in groups.

Description: |Portable devices Only
Each Classification has a

° - name (Classification) and
Classification Description Active?
Description. In addition, a
Hand Tools Yes : ’

ety Equipment Yes H H

P T i Classification may be
Welding Equipment Yes

designated as Active or
Inactive.

e (Classification (name) may be up to 20 characters and is required. The Classification (name) must
be unique (i.e., no other Classifications may have the same Classification (name).

e Description may be up to 80 characters long and is not required.

e A Classification set as active may be assigned to a tool.

e A Classification set as inactive will not be available for assignment to a tool.

Setting a Classification to inactive reduces clutter in the system but retains historical information that
is tied to that classification.

To add a new Classification, select the Add button.

1. Enter the new Classification (name) and Description (optional).

2. Select the Save button to save the new Classification.
To edit an existing Classification, select the Classification to be edited from the listing and then select
the Edit button.

1. Modify the Classification (name), Description, or Status (Active vs. Inactive).

2. Select the Save button to save the changed Classification.
To delete a Classification, select the Classification to be deleted and then select the Delete button. The
system will check to see if the Classification is assigned to a tool. If so, the system will not allow the
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Classification to be deleted. You may inactivate the Classification to prevent it from being assigned to
future tools if you desire.

TYPE:

r?( Tool Suppeort Administration

[

Tool Support Administration
Type is a subclass of

s Add // Edit Delete @ Print List . .
| + | | - | | 23 | | | Classification. Each
Classification (F1) Type (F2) . .
- Classification can have
Classification: |Hand Powered Tools j
Type: [Croular Saw several Types. In addition to
DeEInT grouping tools under a Type,
Depreciation: |5 Years the Type W|” a|SO Set the
2 e c _— .
Description Dep. Reservable | Active? defaUIt deprECIatlon perIOd
5 Jves ____|ves | ; .
Cordless Drill Battery Powered a Y ‘( for tOOIS ass'gnEd to It-
Electric Drill Corded Electrical Drill 5 Yes Yes
Reciprocating Saw 5 Yes Yes

Each Type has a name
(Type), Description, and
Depreciation period in years.

e Type (name) may be up to 20 characters and is required. The Type (name) must be unique (i.e.,
no other Types may have the same Type (name)).

e Description may be up to 80 characters long and is not required.

e Depreciation may be up to 255 years and is not required.

e Tools of this Type can be flagged as reservable by checking the checkbox. This will make them
available when using the Reservation function.

e AType set as active may be assigned to a tool.

e AType set as inactive will not be available for assignment to a tool.

Setting a Type to inactive reduces clutter in the system, but retains historical information tied to the
type.

To add a new Type, select the Add button.

1. Select the appropriate Classification for the new Type.

2. Enter the new Type (name), Description, and depreciation period.
3. Select if the type is reservable.

4. Select the Save button to save the new Type.

To edit an existing Type, select the Type to be edited and then select the Edit button.

1. Modify the Type (name), Description, Depreciation, or Status (Active vs. Inactive).

2. Select the Save button to save the changed Type.
To delete a type, select the Type to be deleted and then select the Delete button. The system will
check to see if the Type is assigned to a tool. If so, the system will not allow the Type to be deleted.
You may inactivate the type to prevent it from being assigned to future tools if you desire.
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The Tool Master Screen is used to ensure that like items are entered into TTS the exact same way. This
helps when searching for tools and items within your inventory. The goal is to establish a standardized
way of entering your equipment that utilizes a “Master Number” to track each tool. A Model Number
can commonly be used as the Master Number since it uniquely identifies the manufacturer and model
being tracked. This master list can also be called a Part Master, Item Master, Lot Number, or other
common term.

FIND MASTER/CATALOG (F1)

Two tabs are displayed. The first is the “Find” tab allowing you to filter and view those items within the

master by:
e Manufacturer
° Class|flcat|0n File View Support —Labels  Help
R 2 2 Tool Tracking System A
e Type ’ A A P Y A IR 8. B i Ecition A
[ Catalog ==
[ ] —
Statu S Find Catalog (F1) Catalog Information (F2)
e Andasearchb —
y I Manufacturer- | All | Classification: | All = [ . O e
Master Num ber, Search Fiel: Catalog =] Type: [AT 7 &=
Description, or '
Model - —
Catalog Classification Type Description Manufacturer Model Number Status B
R e e e i I
Several key aspects are oz e Temsmrg 2 XM e
. 2445.20 = san Jig Saw Tg‘zsf;"d‘“s High Performance . kee 244520
available on the form. As an W e 2 Lireon
252020 e Saw Reciprocating Cordless Hackzall Reciprocating  Milwaukes 262020
. Saw
example, selecting the Reset [ . e M2 FUBL 59 GraorSom Wiochzs._[25020
. 270220 Tonu Cordless x;:“ﬁ'[‘)"'ﬁ";‘[;?;"ﬂ'“sy“e” Niwaukes 270220
b Utto n WI I I ret u rn a I I 2KFY4 . Safety Equipment Dust Mask Nuisance Removal Dust Mask Condor 2KFY4
. ape 38126 A Hammer Claw Craftsman 16 oz. Cuned CIaw ¢, man 38126
selections to All. In addition, — - T o
— all Pein Grfoman 16 0 - ratman
the Master I|St can be SO rted 537820 T it Corded i Pt Gt Dual Toae.— ijuaukeo 537820
Double-click to view Catalog Information 17 rows found
by one of its columns by ——— ————

clicking on the heading of that column. A second click will reverse the sort order of the items in the
listing.

SEARCH FIELD

Groups of master records can also be displayed by selecting Description in the Search Field dropdown
list, typing words in the Search box, and then selecting the Extract Data button. For example, type the
word “drill” into the box and click Extract Data. Only tools that have the word “drill” in the description
will be displayed.

ADD TO LIST

The Add To List button can be used to build a custom list of tools. When selected, it will appear to
remain depressed. When in this mode, tools that are extracted will be added to the list of tools already
shown on the screen, rather than clearing the screen first. You can continue to change the selection
filters and extract the tools you need to build your list. The list can then be printed or exported.
Clicking the Add To List button a second time will return the Extract Data function to its normal mode.
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PRINT LIST

To print the Tools in the list, select the Print List button. A report is displayed and if the default printer
is set, the Tools displayed on the screen will be printed when Print is selected. You may also PDF or
Email the report directly.

PRINT BARCODE LIST

Print Barcode List will print a list of the displayed tool barcodes that can be used for scanning. The list
will include the Master Number, Master Barcode, Description, Model, and Status. When the Print
Barcode List button is selected, a pop-up window will appear where you can set the barcode row
height. This allows you to control the space between barcodes on the list. The minimum row height is
0.5 inch.

EXPORT LIST TO FILE

Export List To File will export information for the displayed tools to a tab delimited text file.

Any highlighted Master tool can then be viewed in the Master Information by double-clicking the
record or selecting the tab.

] catalog ()
- —
Find Catalog (F1) Catalog Information (F2)
Catalog Information
Classification: ‘ Hand Powered Tools j Catalog: ‘245[1722
Type: ‘ Cordless Drill j Manufacturer: ‘ Milwaukee j Previous Hext
Description: [Milwaukee M12 2450-22 cordless Model Number: ‘M12 2450-22
Impact Drivers
Status
& Active " Inactive E|‘""':I|'] Add
// Edit
L
% Delete
Primary Data Purchase / Warranty Images & Docs User Defined Data
. Copy
Tool Image: ‘Iu'!lL’.’\'AUKEE 12 2450-22 CORDLESS IMPACT DRIVER JPG E]
Attached Images & Documents - B Print
CAGIGATRAKITOOL TRACKING SYS.. \MILWAUKEE M12 DRILL SERVICE PARTS LIST.PDF CD Info
CAGIGATRAKNTOOL TRACKING SYS.. \MILWAUKEE M12 DRILL OPERATOR MANUAL.PDF

With selected fields included, you are able to standardize the parameters for the Master tool item
being entered.

NOTE: If you edit or change any information in the Master Information, you will be prompted as below:
Do you want to update all matching Tools’ data with the Master Information?

This could result in any custom changes to individual tools to be lost.
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This allows any change to be updated in every record tied specifically to this Master Record.

REMEMBER — You only need to add a specific model of tool ONCE in the master. The COPY function just
saves you time to create a similar record but still make appropriate changes to differentiate the tools.

The Tool management process is started by selecting the Tool button on the main toolbar, which
displays the screen below.

==
Zl2lel=c]e L NG L 2
R Tools ==
Find Tool (F1) Tool Information (F2) Tool History (F3)
Find Tool Th T | t
— e Tool managemen
Location: | All C\assmnatm: IAH % & % g
Funding Source: [Al Type: [AT ERE I form is composed Of

Account: [All

Manufacturer: [ Al
Condition: [All

Fre—— T
SRR (oo Rae) v s | [ Eoe h bs:
Search Field: [Barcode Other Search Field: [Al 4 - fle three tabs:
=) Change Storage

Search Other Search: | B iocasion

Manufacturer Model Number  Serial Number  Storage Location

Lellefle e fleledle

Ll

T o — | e Find Tool
BinQty Q. o Date Out  DueDate  Funding .
e Tool Information

‘Shalf 100 (ACME Central

| Hammer-Ball Peen Stanley. HO0001E Warehouse)

5 Capital B

" Shelf 100 (ACME Central T I H i t
00008 ~— Hamme - Framing Stanley HO0002E [rmslied 2 Capital B [ ] (o]0} ISTOor
To0003 = Milwaukee Mamp Sawzall  WE00004 Miwaukee MKO002E MK34534500 3;'3:::352‘)5”5 ] Capital B
To0004 = Milwaukee Hamp Sawzall Miwaukee MKO002E MK2585-389453  Snelf 200 (ACME Central Capital B
Warehouse)
Miwaukee 1-2in Magnum Shelf 100 (ACME Central
To0001 N\ WE00001 Miwaukee MKO0DTE npsasoaas  orel 100 Capital B
Miwaukee 1-2in Magnum Shelf 100 (ACME Central
Too002 TN iy WE00002 Miwaukee MKO0OTE Tousss o100 Capital B
- . Shelf 100 (ACME Central Operating
00005 <" Salety Glasses - Clear Balle BLOODIE P 12 ot
o) 8
Doubl-click to view ToolInformation_Use % for wildcard 8 rows found
Userame: User, Adrin Dstabase: C:GgaTraNTol Tracking Systamven_ts

FIND TOOL

The first tab is used to view tools, print a list of tools, and print tool labels. The list of Tools on the
screen is controlled by the multiple selections on the upper part of the form. These selections are:
e Facility
e Location
e Funding Source

e Account

e Manufacturer

e Condition

e Search (by barcode, asset number, description, in service date, model number, notes, and serial
number)

e Master Number (or Catalog)

e (Classification

e Type

e Status

e Other Search (Binned Tools, Consumable Only, Assigned to Employee Barcode, Assigned to
Location Barcode, and Assigned to Container Barcode)
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All of these selections are administered under the support menu of the main form. Each is tied to a
tool in the Tool Information tab of this form. Select the parameters of choice and then select the
Extract Data button to change the tool display.

Several key aspects are available on the form. As an example, selecting the Reset button will return all
selections to All. In addition, the Tool list can be sorted by one of its columns by clicking on the heading
of that column. A second click will reverse the sort order of the items in the listing.

SHOW THUMBNAIL IMAGES

If an image is assigned to a tool, a thumbnail picture will be

. . L . Description Asset Number
displayed in the Description column of the grid. The e
Hwaukee 1-Zin num
thumbnail display can be turned on or off by right-clicking in Iw\ Drill 0-850R.2) s WE00001

v Show Thumbnail Images
1]

the grid and selecting “Show Thumbnail Images” in the ‘u\ hDAi'IﬁVEUSkSeOeF Vs Tiane
i U-

"1 Milwaukee 11amp Sawzall WE00004

popup menu.

NOTE: Some images may be incompatible with this

application. This can cause errors when data is extracted on the Find Tool tab. If errors occur, find a
tool that does not have an image (or add a new tool without an image) and display it in the grid. Right-
click the item in the grid, and uncheck Thumbnail Images.

A larger view of the image can be displayed by selecting “View Image” from the popup menu.

SEARCH FIELD

Groups of tools can also be displayed by typing words in the Search box, and then selecting the Extract
Data button. For example, select Description in the Search Field dropdown list, type the word chair into
the Search box and click Extract Data. Only tools that have the word chair in the description will be
displayed. If a Location is also selected, only tools that are located at that location and have the word
chair in the description will be displayed.

To find a specific Tool by its barcode:

e Select Barcode on the Search Field drop-down list

e Select the Barcode text box (background turns yellow)

e Type in the barcode and select the Enter key on the keyboard, or scan the barcode with a wedge
type barcode scanner attached to the PC

o If the barcode matches that of a tool, the Tool will appear on the list

ADD TO LIST

The Add To List button can be used to build a custom list of tools. When selected, it will appear to
remain depressed. When in this mode, tools that are extracted will be added to the list of tools already
shown on the screen, rather than clearing the screen first. You can continue to change the selection
filters and extract the tools you need to build your list. The list can then be printed or exported.
Clicking the Add To List button a second time will return the Extract Data function to its normal mode.
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CHANGE STATUS

The Change Status function is used to change the Status of a I Y
group of tools all at once. Display and select the tools that you Number of selocted Tools: 1
want to change. To select multiple Tools, do one of the Change the status of all selected toals to-
fOHOWing: Select New Status
e Dragthe mouse over the Tools desired while holding " Active
down the left mouse button.  Retired .
e Select the first Tool by left clicking with the mouse. " Lost |
Select the last Tool in a range by holding down the Shift ABroken
key and then left clicking on the last Tool. All Tools in [ |
between will be selected. il A1\ CAUTION: This will change the status
e Hold down the Control (Ctrl) key and select the Tools you
wish to change by left cﬁickir)1g o»; each one with the ! @ o8 l ’@ S ]

mouse.

After the tools are selected, click the Change Status button. A
screen will appear where you can select a new Status. Select the new Status and click the OK button.

CHANGE STORAGE LOCATION

The Change Storage Location function is used to change the storage location of a group of tools all at

once. Display and select the tools that you want to change. -
Change Storage Location

To select multiple Tools, do one of the following:
. . . Number of selected Tools: 1
hd Drag the mouse over the Tools desired while h0|dmg Change the storage Location of all selected tools to:
down the Ie‘ft mouse bUtton" . . Facility: |ACME Central Warehouse j
o Select the first Tool by left clicking with the mouse.
Select the last Tool in a range by holding down the ~TEITY =] |
Shift key and then left clicking on the last Tool. All
Tools in between will be selected. | /1. CAUTION! This will change the storage
¢ Hold down the Control (Ctrl) key and select the : stonlii tlsesale e
Tools you wish to change by left clicking on each l ﬁ - l l @ Cancel l
one with the mouse. ___

M— e

After the tools are selected, click the Change Storage
Location button. A screen will appear where you can select a new Facility and Storage Location. Select
the new Facility and Storage Location and click the OK button.

PRINT LIST

To print the Tools in the list, select the Print List button. A report is displayed and if the default printer
is set, the Tools displayed on the screen will be printed when Print is selected. You may also PDF or
Email the report directly.

PRINT BARCODE LIST

Print Barcode List will print a list of the displayed tool barcodes that can be used for scanning. The list
will include the tool descriptions, model numbers, and serial numbers. When the Print Barcode List
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button is selected, a pop-up window will appear where you can set the barcode row height. This allows
you to control the space between barcodes on the list. The minimum row height is 0.5 inch.

PRINT TOOL LABEL

To print tool labels:
e Select one or more Tools in the list,
e Select the Print Label button.
For label printing, multiple Tools may be selected. To select multiple Tools, do one of the following:

e Dragthe mouse over the Tools desired while holding down the left mouse button.

o Select the first Tool by left clicking with the mouse. Select the last Tool in a range by holding
down the Shift key and then left clicking on the last Tool. All Tools in between will be selected.

e Hold down the Control (Ctrl) key and select the Tools you wish to print by left clicking on each

one with the mouse.

EXPORT LIST TO FILE

Export List to File will export information for the displayed tools to a tab delimited text file.

Selecting a tool and then selecting the Tool Information tab, or double-clicking on a tool, will bring up

the Tool Information screen below.

S — 2 Tool information with bold text
- above is required. Many of the
s fields listed below are included in
— the sub-tabbed section in the

i lower portion of the form. The
available tool information is:

Database: C\GigaTrakToo Traking Systomwin ts

e Master Number is a selection to pull down general Tool information from the Master screen

e (lassification is a method of grouping Tools

Type is a subset of Classification and a second method of grouping Tools

Description is up to 80 characters describing the Tool

Facility is the building in which the Tool is located

Storage Location is the default storage location for the Tool

e In Service Date is the date the tool was put into service (defaults to current date)

e Barcode is the barcode that identifies the Tool. You must enter the first tool’s barcode number
manually in a format that all barcodes will use (i.e. AO0001). The system will then automatically
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increment the numerical portion of the barcode number one at a time. If you are using pre-printed
barcodes, enter the number seen on the barcode.

Asset Number is the tools asset number, up to 30 characters

Condition is the physical condition of the Tool. Condition does not apply to binned items.
Manufacturer is the manufacturer of the tool (data entered on the Manufacturer Administration
screen)

Model is the model number of the Tool

Serial Number is the Serial Number of the Tool

Funding Source is the agency that provided the Tool (User Definable Field)

Account is the account number used to purchase the Tool

Status. An Active tool may be checked out, A Retired Tool may not be checked out.

PRIMARY DATA SUB-TAB

Note is up to 255 characters of information about the Tool

Container allows other tools to be checked out to the container itself (i.e. tool box)

Binned Item is used for small items that cannot be individually bar coded. If the Binned Item
checkbox is checked, an option will appear to mark the tool as a Consumable. Boxes will also appear
to enter a Storage Bin Quantity and a Reorder Point.

Check Out shows who or where the tool is checked out to (employee or location)

Due Date is the date the Tool is due to be checked in

PURCHASE / WARR. SUB-TAB

Purchased From allows entry of general supplier information
Warrant Expiration Date tracks when a warranty period expires
Depreciation period in years (does not apply to bin items)
o NOTE: fields relating to Depreciation will not be visible unless the “Show Depreciation”
checkbox is checked on the Setup Options screen.
Depreciation Type. The system will calculate depreciation based on five methods: Standard Straight
Line, MACRS Half-Year, MACRS Mid-Quarter, MACRS Double Declining Half Year, and MACRS Double
Declining Mid Quarter
o MACRS means Modified Accelerated Cost Recovery System
Original Value is the cost basis for depreciating the Tool
Salvage Value is the remaining value of the tool after it has been fully depreciated
Current Value is the current depreciated value of the Tool (calculated)
Date for Current Value is the date used to calculate the current value
Miscellaneous is a user definable field that can be used as desired

IMAGES & DOCS SUB-TAB

Tool Image is the path to a file that contains a picture of the tool. If the image information is
entered and a file is at the proper location, the picture will be displayed in the area to the right of
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the sub-tab section. Double clicking on the image will display a full sized image of the picture. In
addition, linked documents, PDF, URLs, and other related files can be assigned to the Tool.

BINNED AND CONSUMABLE ITEMS

Binned and Consumable items must be selected at the time the tool is entered via the Add button. Due
to the different methods that bin and consumable data is tracked in the system, the Bin selection
cannot be changed with the Edit function.

Binned items are small items that would not be individually bar coded, such as screwdrivers. They
would be located in a common bin with a single barcode. When they are checked out, they are
expected to be returned.

Consumable items are a subset of binned items. Consumables are items that are checked out but not
expected to be returned, such as gloves.

Binned and Consumable items have a Reorder Point. This is the minimum quantity that you want to
keep in inventory. When the Storage Bin Quantity reaches the Reorder Point, the item will appear on
the “Bin Tools Below Reorder Point” report.

ADDING A NEW TOOL

To Add a new Tool, select the Add button. All information is cleared and the Save and Cancel buttons
appear. You can pre-enter in information by selecting a Master Number or enter in all information
without referencing the Master Number.

If turned on in System Setup, the system will automatically generate a unique barcode for the tool if the
barcode field is blank. If a specific barcode number is needed, just enter the number manually. Each
barcode number must be unique. Select or enter the required information (bold labels). Enter the non-
required information if desired. Save the Tool by selecting the Save button. The screen will return to
the original state with the new Tool information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original

state with the information displayed that was present prior to selecting the Add button.

EDITING AN EXISTING TOOL

To Edit an existing Tool, select the Edit button. The Save and Cancel buttons appear.

Change the Tool's information as desired. Information with bold labels is required. Save the Tool by
selecting the Save button. The screen will return to the original state with the changed Tool
information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the Tool information unchanged.
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COPYING AN EXISTING TOOL'S INFORMATION TO A NEW TOOL

This is one of the most helpful features when multiples of the same type of tool needs to be entered.
To Copy an existing Tool's information to use in creating a new tool, select the Copy button. The
majority of data is copied to a new record. The exception is that the barcode number, serial number
and checkout information is cleared and the Save and Cancel buttons appear.

The system will automatically generate a unique barcode for the tool. If this barcode is unacceptable, it
can be typed over by the user. The barcode entry must be unique. A barcode for a tool, location, or
employee cannot be the same. Change the Tool's information as desired and add the new barcode.
Save the Tool by selecting the Save button, the screen will return to the original state with the new Tool
information.

Cancel the process without saving by selecting the Cancel button. The screen will return to the original
state with the Tool information unchanged.

To Delete an existing Tool, select the Delete button. After asking if you are sure, the system will delete
the tool.

Selecting a tool and then selecting the Tool History tab will bring up the Tool History screen below.

: — The screen displays the history of the
— ‘- E3k selected tool for the date range

FodTool®) | Toollofomation ) Tool History (F3)

5
Reports

uuuuu

selected. The system defaults the
date range to the last 12 months.
8 [ Change one of the dates and select

\\\\\\\\

the Enter key or select a new date
with one of the calendar controls and
the list will change to reflect the new
date range.

To print the history displayed on the
screen, select the Print List button.

s e Uses Adon Datstose: CiGigsTokTool Trackng Syseni s e

To remove all history records prior to a specified date, enter the date in the Date text box and then
select the Purge button. All history records prior to the date specified will be delete.
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The Check Out process is used to check tools out to an employee or location. The Check In process is
used to check tools into storage from an employee or location. Check Out and Check In can also be
performed on the handheld unit. To start these processes, select the Check In/Out button.

CHECK OUT

The Check In/Check Out process is composed of three (3) tabs. The first tab is the Check Out process as
shown below.

4 G To check out tools:
Check it { e (e Qrece S | @ Select a Container, Location, or
e 1 T T T Employee to which the tool will be
Bavode: 10| Location Obfae Terminal 2 Constrction checked out

Manmnig [ Defaut Intenal:
e et [HEE ] o [

Note:

e If desired, enter the due date for the

ToolBarcade: (=] st return of the Tool. Enter a date in the
Change Out DeieTme:
(o i o [ontes cotior o mm e wes wmu | DUE Date box, or enter a Default Interval
oot :]’!"a’ﬁ'u’,ga”‘""'“ﬂ"“’“m' s l‘zﬂ,‘ Good Joks ﬁi’lmlg’“ b fd f d
: E s (number of days from today)
ITO00M3 Mitwaukee 10 amp Sanzall Corded 11202014 Good Jobs

S26AM Construction

T | | ¢ T b
Seff-Contained 14-Ton Crimping Tool 526 AM (Canstruction

o |f the Tool is a binned item, a box will
appear below the barcode to enter the

quantity being checked out

The tool checkout information will be displayed in the grid. To check out another tool to the same
location/employee and with the same due date, scan another tool barcode.

If no scanner is available, you may enter the barcode information into the barcode text boxes and then
press the enter key on the keyboard. You may also select the find button next to the textboxes to
display a list to choose from.

Items that are entered into the grid by mistake can be removed by selecting the item and clicking the
Remove Item button.

Once items are displayed in the grid, the Out Date/Time can be changed by clicking the Change Out
Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for
ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired
date and time.

When all desired tools have been checked out, select the Save or Save/Print button. The check out
information will be saved and, if Save/Print was selected, the system will ask if you wish to print the
check-out report. The system will then clear the check-out list.
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To cancel the check-out process, select the Reset/Clear button. After confirming you wish to reset the
check-out process, the system will clear the check-out list without saving it.

CHECK IN BY TOOL (F2)

To check in an individual tool, select the Check In by Tool tab. The screen will change as indicated
below.

7 e = To check a tool into storage, scan the
e § = (gowms @ueos S weews  too] barcode or enter the tool barcode

Check n by Tool 2

— and then press the Enter Key on the
wlbate [ [ Desiin . . .
e - keyboard. If the tool is a binned item,

a box will appear to enter the quantity
(i) being checked in. The check in

Barcade Description DueDate InDate  Condifion  Facility Location BinQty  From Status Miles  Hours . . . . .
EaRaRTTREEIRE e e
Condition, Facility, and Storage

Location may be changed. Select the
column you wish to change, select the
Enter key and pick the new Condition,

Facility, or Storage Location from the
list.

Once items are displayed in the grid, the In Date/Time can be changed by clicking the Change In
Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for
ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired
date and time.

When all tools have been checked in, select the Save or Save/Print button. The check in information
will be saved and, if Save/Print was selected, the system will ask if you wish to print the check in report.
The system will then clear the check in list.

To cancel the check in process, select the Reset/Clear button. After confirming you wish to reset the
check in process, the system will clear the check in list without saving it.

Check In can also be performed on the handheld unit.
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CHECK IN BY CONTAINER / PERSON / LOCATION (F3)

To check in tools assigned to either a container, an employee or a location select the Check In by

Container / Person / Location tab. The screen will change as indicated below.

& Check /Ot
Checkn E Save (_Esﬁmprim @ lhse'll[lenl| B exmorefen
| | =
Check Out 1 Check In by Taol [F2) Check In by Container | Person I Location (F3]

" Container & Location " Employee Contractor

Barcode: /003 [=] Location: OHare Teminal 2 Cansiuction
¥ CheckAl  Only checked rows will be checked in Copy Row

o0R
Scan Tool Barcade: Change Status: =
Change i DaielTme
Chk Barcode Description Due Date  In Date Condition Facility Location Bin Qty | Status Hiles Hours
BT Mitwaukes 1/2in Magaum Drill . ... 204 ACME Warehouse
¥ T00001 02300REM 1202014 12840 Good 2 Shelf 101
Milwaukee 10 amp Sawzall 2014 ACME Warehouse

00 Toooo3 C T2 o Shetf 101

ared g S0t 2
Bumdy Patriot 18 Volt
00020 Hydauc SeiComaned | iz | 2T (DB Lot 1
14Ton Cimping Tool
iy

Bumdy 18V Hydraulic il ACME Central

[T SelfContaned Cutter e B e RO
@ Tooos Mtz 10 amp Sl AR NeessRepa porCoE gy
7 Tt & Foat Aluminum Step Ladder han Excolln ATVEVEERSE g
_ Viwaukee 112 245022 T ACHE Centa

H | o cordless Impact Drivers G28AM Bucsllert Warshouse Sheff 100

To check a tool into storage,
first select or scan the
container, employee or location
barcode the items are being
returned from. A listing of all
items checked out to the
container/employee/location
will be displayed. You can then
click the check box for each line
item being returned. Binned
item quantities can also be
changed in the grid if desired.

A Check All option box will check or uncheck all checkboxes for each line item listed. Alternately, you

can scan individual tool barcodes to check the checkbox. You can also change the status to Lost or

Broken for any items checked. The change occurs on Save. If someone returns multiple tools but has

lost others, check-in the returned items first and Save. Then, do a new check-in for the individual and

confirm that the remaining items listed are lost. Check All and Change Status to Lost then Save. The

COPY ROW function allows you to split up binned items being returned so that alternate locations can

be assigned. Verify the QUANTITY is correct before saving!

Once items are displayed in the grid, the In Date/Time can be changed by clicking the Change In

Date/Time button. A confirmation box will appear to indicate that the date/time will be changed for

ALL items shown in the grid. Responding “Yes” will display a calendar where you can select the desired

date and time.

When all tools have been checked in, select the Save or Save/Print button. The check in information

will be saved and, if Save/Print was selected the system will ask if you wish to print the check in report.

The system will then clear the check in list.

To cancel the check in process, select the Reset/Clear button. After confirming you wish to reset the

check in process, the system will clear the check in list without saving it.

Check In can also be performed on the handheld unit.
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Transferring Tools is a process used to relocate tools from one Facility/Location to another. To start
this process, select the Transfer Tools button. Keep in mind that only Facility/Locations designated as a
Transfer Location on the Location Administration screen will be displayed in this form.

Understanding the basic transfer process is important. Just because an originating location transfers
“Out” tools to a destination location does not mean that all of the tools arrive as intended. To manage
this process requires BOTH the sender and receiver to acknowledge the items being transferred. If the
sender lists ten (10) tools that they sent, but the receiver only acknowledges eight (8) tools — two (2)
tools are now unaccounted for. It becomes the responsibility of both parties to resolve the
discrepancy. The remaining two (2) tools will still be shown in the Transfer Out screen of the sender
and must be reconciled at some point. If lost, the best method to correct the problem is to:

1. The sender selects the lost tools in the Cancel Transfer screen and saves the transaction. The
tools are now in the sender’s inventory.

2. The sender then selects the individual record for each lost tool and changes the tool status to
“Lost”. Inventory is now accurate until the lost tools are found.

The Transfer Out process allows the user to select a Location Barcode that the selected tools will be
transferred to. Once a location is selected, the user then scans all of the tool barcodes being
transferred. You must

W Tansfer = . .
Transfer Out l H Save l;:"H Save / Print e Reset | Clear % Remove Item e nter the q ua ntlty be ! ng
transferred for binned
Transfer Qut (F1) Cancel Transfer (F2) Transfer In (F3)
Crecked Oul To items. CAUTION: When

O'Hare Terminal

Loc. Barcode: [AW2TR E Location: TRANSFER TO AW2 12 Canstruction . .
transferring binned
ToolBarcode: [c] Descrption: items, the system will
Barcode Description OutDate  Facility Location Bin Qty try an d matc h u p
MA7™ Cordless LITHIUMAON 1/2"  11/4/2014 ~ ACME Central
00012 Hermmer Dill Diver Kit 933AM  Warehouse TRANSFERTO AW2

barcode IDs based on
the Master ID of the
item being transferred.

Bumdy Pariot 18 Volt Hydiaulic | 11/4/2014  [ACME Central

Adjustments to
inventory may be

necessary should IDs

not match.

The Cancel Transfer process allows the sender to cancel items being sent, and returns them to
inventory. Select the Cancel Transfer tab on the Transfer form to proceed.

To cancel a transfer, the user needs to first select the destination location where the tools were
“Transferred Out” to. It is important to note that only those inventory items not yet “Transferred In” by
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the receiving location will be listed. The user only needs to check off the line items being cancelled and

save the transaction.

TRANSFER IN

B8 Transfer
Transfer In a Save Cﬂmlmm émmluﬁr & Remove lizm
Transter Out [F1) Cancel Transler F2) Transfer In (73]

Loc. Barcod: [ANZIR (o] Location: TRANSFERTO AW2

™ CheckAll - Only checked rows will be transfemed in - Change Location: &

Description InDate | Location Bin Gty
W™ Cardess LITHUMAON 10472014
112" Hammer Dell Dier kit~ 334 AM

Wazou
934 AM

[ etk Barcode
O T

Bundy Patict 16 Vol
Toog20 Hytiauic SeF Contined
14%n Cimping Tod

The Transfer In process allows the

receiver to acknowledge receipt of
transferred items being sent to their
inventory. If all items are receipted, just
select Check All and Save. If you desire to
change the receipted location, select the

Change Location dropdown. Any checked

items will be relocated to the designated

location upon Save.

Reserving Tools is a process used to reserve the use of a tool for a specified period of time. To start this
process, select the Reserve button. The screen below will be displayed.

FIND RESERVATIONS

The Reserving Tools process is composed of two (2) tabs. The first tab is the Find Reservations process.
This is used to find the current reservations for a tool or employee/location.

[ Tool Reservation

Find Reservations (F1) 1

Reseration Admin (F2)

Find Reservations

Reservation Type: IAH j

.| Name:
Phane:
Alt Phone:

Tool Barcode: IA\I B E/\iz:y —
Serial Number:

From: [104/2013 [..] To: =)

User [ Location IA\I
Barcode:

q’ Purge Reservations

From To

8/6/2014

Priority

User Tool
J003 - O'Hare Terminal 2 Construction

T00012 - MA7™ Cordless LITHIUM-ION
1/2" Hammer Drill Driver Kit

T00010 - Milwaukee 7-1-4 Right
Circular Saw with QUIK-LOK cord
T00012 - M17™ Cordless LITHIUM-ION
1/2" Hammer Drill Driver Kit

T00009 - MILWAUKEE 7-1-4 LEFT
BLADE CIRCULAR SAW

(Jobs)

E002 - Doe, Mary 9/24/2014  11/5/2014  Medium

E002 - Doe, Mary 12/31/2013 /312014 Low

E001 - Smith, John 10/22/2013 10/28/2013  Medium

Notes

To view the
reservations for a
User/Location, scan
the User/Location
barcode into the
User/Location
Barcode textbox and
the reservations for
the User/Location in
the date range
specified will be
listed.

To view the

reservations for a tool, scan the Tool barcode into the Tool Barcode text box and the reservations for

the Tool in the date range specified will be listed.
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If no scanner is available, you may also enter the barcode in the barcode text boxes followed by
pressing the Enter key on the keyboard. Another option is to select one of the find buttons, to display
a list from which you may select.

To change the date range for the reservation list, enter a new date and then select the Enter key or set
the date using the calendar control. The list will change to reflect the new date range.

Zind Reszvation (77) Resenvation Admin (F2)
Reservation Admin

‘* Md‘ “/} Edi!‘ ‘%Delele‘
Clozatin  © Emgloyee
BRI - E oo The second tab is the Reservation
FromDate: [I3U2015 [] Time: [ AtPane
ot [ACEE ] e Admin process. The Reservation
Priority
g e Admin process is used to add new
T —TT reservations and edit or delete

existing reservations.

User Nane: User, Admia Catatase_CAGgaTIaHTocl Trecking Systemvin_tsmd

To add a new reservation:

e Select the Reservation Admin tab,

e Select the Add button, the screen changes as indicated.

e Scanthe Location or Employee barcode or select the Find button.

e Scan the Tool barcode or select the tool.

e Set the date and time range for the reservation.

e Select a Priority. High Priority items cannot be checked-out to any person or location except the
one holding the reservation. Low/Medium Priority settings alert the person checking out the
tool if it is to a different location/user than the one holding the reservation.

e If you desire, add a note and set the priority, then select the Save button.

To edit an existing reservation:
e Find the reservation in the Find Reservation tab,
e Select the Reservation of interest,
e Select the Reservation Admin tab,
e Select the Edit button,
e  Modify the information as desired,
e Save the reservation.

To delete an existing reservation:
e Find the reservation in the Find Reservation tab,
e Select the Reservation Admin tab,
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e Select the Delete button.

After verifying the deletion, the system will delete the reservation.

2 Reports

Reports

Select Report

Report Filters

[Bin Tools Below Reorder Point

Consumable History by Container
Consumable History by Employee
Consumable History by Location
Consumables in Stock by Facility
Consumables in Stock by Location

Excpired Warranty by Facility

Expired Warranty in Next 60 Days

Tool Assignment by Class and Type

Tool Assignment by Class, Type and Employee
Tool Assignment by Class, Type and Location
Tool Assignment by Container

Tool Assignment by Employee

Tool Assignment by Employes (Split Pages)
Tool Assignment by Employee (With Responsible Locations)
Tool Assignment by Location

Tool Assignment by Location (Split Pages)
Tool Assignment by Storage Location

Tool Assignment by Tool

Tool Assignment Status by Employee

Tool Assignment Status by Lacation

Tool Audit

Tool Depreciation by Class and Type

D Print Report

Each report has a different set of Report
Filters that the user can select to create
the report results they desire.

When the filters are set, the user then
selects the Print Report button. A print
preview screen will be displayed from

which the report may be printed, PDF'd or

Email(ed) (only if Microsoft Outlook is
used).

The Tool Assignment and History Reports (see screen above) give you the ability to Auto E-Mail the

report when desired. Select “Email Report(s)” so that each person gets their own email with their

information. Only employees with an email address record will receive their email report.

All other reports follow a similar selection process depending on the report selected. Make sure to

select all settings necessary to generate the report you desire.

If desired, GigaTrak can provide custom reports at your request. These reports will be quoted

separately and automatically added to the Select Report listing when installed.
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Two types of handheld applications are available, batch mode and wireless.

Batch handheld units hold data in a mobile database file that gets transferred back and forth between
the handheld and the host PC. These units will work with both Microsoft Access and Microsoft SQL
Server host databases. The handheld must be docked with the host PC to perform the transfer. The
tool data on the handheld is a snapshot of the data on the host PC. If there are multiple users changing
data on the host database, the handheld data may be outdated in a short period of time. Therefore, it
is important to synchronize the handheld with the host PC often, so that it has current information.

Wireless handheld units communicate with the host database in real time. This requires the host
database to be Microsoft SQL Server. Your facility will have to have a wireless infrastructure in place
for communication. No data is stored on the handheld.

Communication software must be installed on the host computer. Choose the correct software based
on the operating system of the host computer.

MICROSOFT ACTIVE SYNC INSTALLATION (FOR WINDOWS XP)

1) Locate a copy of the latest version of Active Sync for your computer system. The correct version is
available from Microsoft’s WEB site. Version 4.5 is the latest from Microsoft as of this printing.

2) Look for the installation file (i.e. activesync_setup.msi) and run it. We recommend that you follow
the installation instructions and accept the standard default settings during your install.

3) Leave Active Sync running to install and connect your handheld computer.

NOTE: Some users may use a single PC to connect multiple handheld computers. If this is the case, it is
best to setup your PC to recognize each handheld as a “Guest”. This avoids having Active Sync loading
shared data from your Outlook and other PC applications. To set all connected handhelds as a Guest,
please double-click and run the provided “GuestOnly.reg” file. It will instantly update your system for
future connections.

WINDOWS MOBILE DEVICE CENTER INSTALLATION (FOR WINDOWS VISTA OR WINDOWS 7)

1) Locate a copy of the latest version of Windows Mobile Device Center for your computer system.
The correct version is available from Microsoft’s WEB site.

2) Look for the installation file (i.e. drvupdate-x86.exe) and run it. We recommend that you follow the
installation instructions and accept the standard default settings during your install.
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The handheld application can be found in the Handheld folder of your installation CD or download.

1) Connect the handheld docking station to your computer (typically a USB connection) and plug in the

AC power cable.
2) Put the handheld in the dock and wait for it to sync with the PC.
3) Onthe PC, double-click the handheld setup file for the application you are installing (e.g.,

setup_honeywell_hh.exe).

The batch handheld must be synchronized with the Tool Tracking application on the host computer
before it can be used. This will load the current tool information onto the handheld.

1)
2)

1)
2)
3)
4)

5)

6)
7

8)

Start the Tool Tracking application on the host computer and select the Download button.

If your handheld device is not displayed on the screen title bar, click the Select Handheld button
and select it.

Put the handheld in the dock and wait for it to sync with the PC.

Select the Sync Data Automatically button to begin the data transfer. Do not remove the
handheld from the dock until the data transfer is complete.

Install the handheld application to the SD card. The SD card will display on the handheld in My
Device as \SDCard (the actual folder name will vary between handheld models.)

Remove the SD card from the handheld, and place it into the card reader in the PC. Determine
the drive letter assigned to the SD card (i.e. E:\).

In TTS on the PC, go to the Download screen, and click Export Data File Manually. Select E:\ and
click OK.

When the process is complete, safely remove the SD card from the PC and re-insert into the
handheld.

Collect your data, and when finished, repeat step 2.

In TTS on the PC, go to the Download screen, and click Import Data File Manually. Select E:\ and
click OK.

Only committed data gets exported back to the handheld. Therefore, Commit the data on the
Download screen and then follow steps 3 and 4 to Export the most recent data back to the
handheld.

This is an overview of syncing data with the handheld manually. ActiveSync/WMDC running Terminal

Services/Citrix can't sync with a remotely connected handheld. This assumes you already have a data

file on the device and will begin by importing it. (Otherwise, start by exporting the data, later in the

overview.)
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1. Close the TTS software on the handheld. From a PC with a locally connected handheld via
ActiveSync/WMDC (these instructions assume ActiveSync but WMDC works similiarly):

a.

Double-click the ActiveSync icon in the system tray. Click Explore. Navigate to the path
containing the TTS database file, tts_mob.sdf, (on an LXE, this is \System. On a Memor,
this is \Backup. On a Honeywell, this is \Honeywell.)

Open a second window that points to a folder that can be accessed via the terminal
server session (i.e. a file server share, local C: drive, etc.)

Drag the tts_mob.sdf file from the handheld window to the other window to copy the
file.

2. Run the TTS software from the terminal server session. Click Download, then Import Data File

Manually. Point at the folder where the file was copied to. Import the data, and commit as

usual.

3. After commiting, the new data must be exported back to the handheld. Click Export Data File
Manually, select the same folder that was used for import, overwriting the file.
4. Essentially, reverse the copy procedure used for import. Switch back to the local PC, and:

a.

Double-click the ActiveSync icon in the system tray. Click Explore. Navigate to the path
containing the TTS database file, tts_mob.sdf, (on an LXE, this is \System. On a Memor,
this is \Backup.)

Open a second window that points to a folder that can be accessed via the terminal
server session (i.e. a file server share, local C: drive, etc.)

Drag the tts_mob.sdf file from the server-accessible window to the handheld window to
copy the file.
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TTS HANDHELD APPLICATION FUNCTIONS

The following describes basic operation of the Mobile Tool Tracking application.

HANDHELD APPLICATION LOGIN

When the handheld application is first started, a user login will be required.
Scan an employee barcode, or type in an employee barcode and press the
Enter key. If the barcode matches an employee in the data file, the
employee name will appear under the scan box, and buttons for the
application functions will appear.

r
e | WIN-TTS

o
g galrzk
Tool Tracking System
Scan / Enter Employee Barcode:
|El]l]1| " Log Qut |
User: Smith, John

wl.24.0

2014 GigaTrak. All rights reserved,

WIRELESS APPLICATION LOGIN

When starting the wireless handheld application for the first time, you will be
prompted to enter the server name in Admin. Select the Admin button to
display the Admin screen. You will be prompted to enter a password when
you select this function. The password is gigatools. If you are entering the
password on the handheld keypad, be sure you are in alpha mode.

WIRELESS APPLICATION ADMIN

r
e | WIN-TTS

o
ggalzx v1.24.0
Tool Tracking System
Scan / Enter Employee Barcode:
|| " Log In |

2014 GigaTrak, All rights reserved.

The user barcode is tied to the records recorded by the handheld. If a

[ crekost |[ cekn || different employee uses the handheld, he/she should enter their barcode

[ Audt |[[_comten || before recording records. To change the user barcode, select “Log Out” and
Add Mew Tool Identi . .

| v Took || ety | enter in a different employee barcode.

| Assign Barcode | | Maintenance |

Admin

SQL Server Name [ IP Address:

Database Name: DB User ID:

Password:

[ <-Back to Henu | [

Display the on-screen keyboard and enter the SQL Server Name or IP Address, the database name

(typically win_tts), the DB User ID (typically tts_user) and the database password.

Select the Save button when finished. A message will be displayed to indicate that the settings have

been saved. Select the Back to Menu button. Scan or enter your employee barcode to log into the

application. The main menu buttons will be displayed as shown above.
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CHECK OUT

The Check Out function is used to assign tools to employees,
locations or containers.

Scan the barcode of the employee/location/container that is
receiving the tools. If the barcode matches a record in the
data file, the appropriate name will be displayed under the
scan box.

If a Due Date is desired, check the Due Date checkbox. No
due date will be recorded if the checkbox is not checked. A
popup calendar can be displayed by selecting the drop-down
arrow, or enter the number of days the employee will have
the tool.

Scan the tool barcode. If the barcode matches a record in
the data file, the tool description will be displayed under the
scan box. If the tool is not a binned item, the check-out
record is saved. If the tool is a binned item, the “Qty” box

will appear, with a default quantity of one. Enter the appropriate quantity and press the Enter key to

save the check-out record.

,ir .'. | Check Ouk

Check Out
Employee/Location,/Container:

E002

Doe, Mary
[ ] Due Date: | |

[ ]

Mote:

|Juh is very dirty

Tool Barcode: |

Tool checked out successfully.
T00D001 - Milwaukee 1;/2in Magnum
Drill 0-2800RPM

Last Loc/Emp,/Cont: O'Hare Terminal 2

‘ «- Back to Menu | | Reset

Continue to scan the tool barcodes that will be assigned to the employee/location/container.

The Reset button will clear data from the screen without saving it. It will not reset data that has already

been saved.

CHECK IN

File Flash Help

Check In
Change Tool Status:
Tool Barcode;

[Toooo1 |

TOD001 - Milwaukee 1/2in Magnum
Drill 0-2800RPM
Last Loc/Emp,/Cont: Doe, Mary

MNew Storage Location Barcode:
[awzs101] |

Shelf 101

1 data records
Reset |

«- Back ko Menu | |

The Check In function is used to return tools from an
employee/location/container back to a storage location.

The user can change the Tool Status from a drop-down list at
the time of check in. The options are No (change), Lost, or
Broken.

Scan the tool barcode being returned. If the barcode matches a
record in the data file, the appropriate name will be displayed
under the scan box. The current storage location will be
displayed. If the tool is being returned to this location, just
press the Enter key. If it is being returned to a different storage
location, scan the barcode of the new storage location.

If the tool is not a binned item, the check in record is saved. If
the tool is a binned item, the Qty box will appear, with a default
guantity of one. Enter the appropriate quantity and press the
Enter key to save the check in record.
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If the tool is set up for Miles and/or Hours in the host database, the Miles and/or Hours boxes will

appear, with the current readings filled in. Enter the appropriate values and press the Enter key to save

the check in record.

Continue to scan the tool barcodes that will be checked in from the employee/location/container.

Note: Consumable items cannot be checked in. Scanning the barcode of a consumable item will

display the message “Cannot Check In a Consumable”.

The Reset button will clear data from the screen without saving it. It will not reset data that has already

been saved.

AUDIT

The Audit function is used to verify tools that have been
checked out to an employee/location/container.

Scan the barcode of the employee/location/container that
is being audited. If the barcode matches a record in the
data file, the appropriate name will be displayed under the
scan box, and a list of the tools that are currently assigned
to that barcode will appear in the listbox.

Note: binned tools are not audited, and will not be
displayed.

If you audit a container, scan the barcodes of the tools in
the container. If the scanned barcode matches one of the
barcodes in the list, that item will be removed from the list.
Continue to scan the tool barcodes, including barcodes that
do not appear in the list. When all tools have been
scanned, there may be some items still on the list. Those

Audit

Employee,/Location,/Container:

7003 |
O'Hare Terminal 2 Construction

Tool Barcode:

TOO0Z2 ~ Burndy 18Y Hydraulic Self-Containe

1 data records

| <- Back to Menu |

items can be reconciled when the data is downloaded back to the host PC.

The Reset button will clear data from the screen. Tools that were audited will have been saved.
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COUNT BIN

Iy | Count Bin

Tool Barcode:

Count Bin

[Toosoo

Gloves

Quantity:

TO0500 - Leather Surfaced Work

Last Loc/Emp: Shelf 100

4

1 data records

<- Back ko Menu

| | Reset |

IDENTIFY

The Identify function is used to display the description of a tool when the
barcode is scanned. It will also show the last known location or employee
that has it. This is only a lookup function, it does not save data.

ADD NEW TOOLS

The Count Bin function is used to count the number of binned items in a
storage location.

Scan the tool barcode. If the barcode matches a record in the data file,
the appropriate name will be displayed under the scan box. If the
barcode does not match a bin item, the message “Not a binned item” is
displayed.

Enter the number of binned items counted for that barcode in the Qty
box and press the enter key to save the record.

The Reset button will clear data from the screen without saving it. It will
not reset data that has already been saved.

Identify

’
'y

Identify

Tool Barcode:

|

TO0001 - Milwaukee 1/2in Magnum
Drill 0-2800RPM
Last Loc/Emp: Doe, Mary

1 data records

<- Back ko Menu

The Add New Tools function is used to add tools that have not been

added to the host PC database. You will be prompted to enter a password when you select this

function. The password is gigatools. If you are entering the password on the handheld keypad, be sure

you are in alpha mode.

Add New Tools
Current Emp/Loc/Container:

[Eo03

Barnaby, Mike

MNew Tool BC:
Asset &

Serial #:

In Service Date:

Storage Loc BC:

Master Number: (PATTS50-LI

Burndy Patriot 18 ¥olt Hydraulic Self-

TODZ49

BC5464

6546-464

11,04,2014

Loo3]

<- Back ko Menu

| | Reset |

After entering the password, a warning message will be displayed
indicating that the new tool will not be available for use until the data is
downloaded and committed back to the host PC application.

A Master (or Catalog) Number for the new tool must exist in the host PC
database. You will also need to assign a new tool barcode to the tool to
save the record.

Note that you cannot add new binned items with this function.

Scan or enter your employee barcode. If the barcode matches a record
in the data file, the appropriate name will be displayed under the scan
box.

Enter a Master Number (or scan a Master Barcode). If the barcode matches a record in the data file,

the appropriate tool description will be displayed under the scan box.
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Scan or enter a new tool barcode. If an existing tool barcode is entered, a message will appear stating
that the tool BC already exists, and ask is you want to check out the tool instead. Responding “Yes” to
the prompt will check out the tool to the employee/location/container shown on the screen.

Asset # and Serial # are optional fields, which can be left blank. When the focus is on the Serial # field,
press the Enter key to save the record. A message will appear at the bottom of the screen to indicate
that the new tool barcode was added successfully.

The Reset button will clear data from the screen without saving it. It will not reset data that has already

been saved.

ASSIGN BARCODE (BATCH APPLICATION ONLY)

The Assign Barcode function is used to assign barcodes to existing

tools in the database. You will be prompted to enter a password Barcde},;::'tg;f:;;d:
when you select this function. The password is gigatools. If you are [To0001 |
entering the password on the handheld keypad, be sure you are in
alpha mode.
Mew Barcode:
After entering the password, a warning message will be displayed [roo144

indicating that the new tool will not be available for use until the data
is downloaded and committed back to the host PC application.

A second warning message will be displayed indicating that if there is | [_<Backtorenu ] [ Reset |
more than one batch handheld, changing a tool barcode may result in

data loss. Download and commit data from the other handhelds before commlttmg the barcode
change.

Scan the existing tool barcode, asset number, or serial number. If the barcode matches a record in the
data file, the appropriate name will be displayed under the scan box.

Enter a new barcode. If the new barcode is unique, the data will be saved. Ifitis not unique, a
message will be displayed prompting you to enter a unique barcode.

The Reset button will clear data from the screen without saving it. It will not reset data that has already
been saved.
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When you have finished collecting data, the batch handheld must be downloaded back to the host PC

application.
1)

2)
and select it.

3)

4)

Put the handheld in the dock and wait for it to sync with the PC.
Select the Sync Data Automatically button to begin the data transfer. Do not remove the

Start the Tool Tracking application on the host computer and select the Download button.
If your handheld device is not displayed on the screen title bar, click the Select Handheld button

handheld from the dock until the data transfer is complete. If checked in the Setup Options to
Auto Commit Downloaded Data upon Sync this step will already be completed and the

information below can be disregarded.

. Download @
Download Select Handheld Handheld Device: Honeywell Dolphin 6100 Data Dir. \Honeywell\
Import Data Sync Data Export Data Save . g " 2 . .
| File Manually | g & ically File M Iy I Changes Commit g' Clear O Report ,k_\ View Log File
Display Type Yelow Blue Text: Reserved (High Priority) fora  Red Text: Audit Emp / Location / Cont does not
Checkbox different Emp / Location match expected Emp / Location / Cont, or Gty
@Al C Audit ©Out Cin © Count © New  Edit Committed item mismatch
Current Emp / Location / Last Known Emp /
Chk| Type Cont Tool Scan Date (st § B Qty Status Change Scanned By
.. O'Hare Terminal 2 T00020 - Burndy Patriot 18 Volt Hydraulic Y a7 O'Hare Terminal 2
Audit Construction (Jobs) Self-Contained 14-Ton Crimping Tool 17372014 03:27:04 PM Construction {Jobs) Smith, John
O'Hare Terminal 2 P O'Hare Terminal 2
Audit Construction (Jobs) T00035 - Dell XT Laptop 1/3/2014 03:27:07 PM Gt (i) Smith, John
" T00001 - Milwaukee 1/2in Magnum Drill 4. Shelf 101 (ACME
Out Bamaby, Mike 0-2800RPM 11/3/2014 01:13:23 PM Warehouse 2) Smith, John
Out  Bamaby, Mike T00003 - Milwaukee 10 amp Sawzall Corded  11/3/2014 011334 P onelf 107 (ACME Smith, John :
Warehouse 2 3
Out  Bamaby, Mike T00008 - Hammer - Framing 17302014 01:43:54 pp Aist® 1 (ACME Central 1 Smith, John
Warehouse)
T00009 - MILWAUKEE 7-1-4 LEFT BLADE e Shelf 100 (ACME Central
Qut Bamaby, Mike CIRCULAR SAW 11/3/2014 01:14:22 PM Warshouse) Smith, John
R ™ ¥ e
Out  Bamaby, Mike T00011 - M16™ Cordliess LITHIUMAON 34" SDS 4320044 11424 PM Large Rolling Tool Bax Smith, John
Plus Rotary Hammer Kit
Audit  Bamaby, Mike EEJE";UOJR’P“G‘WE”“EE zmiErnm ] 1/3/2014 02:22:48 PM Barnaby, Mike Smith, John
Audit  Bamaby, Mike T00003 - Milwaukee 10 amp Sawzall Corded 11/3/2014 02:22:50 PM  Barnaby, Mike Smith, John
2 q T00009 - MILWAUKEE 7-1-4 LEFT BLADE = === O'Hare Terminal 2
[0 Audit Bamaby, Mike CIRCULAR SAW 11/3/2014 02:22:53 PM Construction {Jobs) Smith, John
- A e T00011 - WM18™ Cordless LITHIUM-ION 3/4" SDS .. cuanss anan - co.  O'Hare Terminal 2 P S
« ’
13 rows found

The data collected on the handheld will be displayed on the screen. At this point, none of the tool data
has been changed in the host database. Click the Commit button to commit the data to the host
database. Only the rows that are checked in the first column will be committed. The user can check or
uncheck the checkboxes as appropriate. This will prevent bad data from being committed to the

database.

Some data can be modified before using the Commit function. For a count record, the Qty counted can
be changed by double-clicking the Qty. For a check in record, the Status can be changed by double-

clicking the Status Change column and selecting from the dropdown list. Be sure to check the checkbox
in the first column if you want the data to be changed.

After the Commit function has been performed, it changes data in the host database. The background
of the checkbox will turn yellow for committed items. All handhelds should be synced with the host to

update the data on the handhelds.
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DOWNLOAD SCREEN

The system provides a function for a batch handheld scanner. The user must first configure the PC for
the handheld in use. Click the Select Handheld button on the Download screen to select the handheld
device you are using. You can also select Handheld Configuration on the File menu to select a

handheld.

L Download

Download Select Handheld | Handheld Device: Honeywell Dolphin 6100 Data Dir: \Honeywell\

[~ CheckAll

" Maintenance

Import Data File B Sync Data Export Data File Save 5 =
- Q C it Cl B Report Vi Log Fil
Manually Automatically Manually Changes ommi ﬂ' ear O ‘epo! ¥. tew Log File
Display Type Yellow Checkbox: Committed item
(o AlE C0out Tn T Count © New T Edit C First Record Download Date: Blue Text: Reserved (High Priority) for a different Emp /
Location
Dispiay Maint ‘ jl“’__f"‘"jr':‘f ‘ Red Text: AudtEmp/ Location / Cont does not match

expected Emp / Location / Cont, or Qty mismatch

Chk| Type

Out

[
o
-4

[«
(=]
=4

=
o
&

Current Emp / Location /
Cont

O'Hare Terminal 2

Construction (Jobs)

O'Hare Terminal 2

Construction (Jobs)

Tool
T00003 - Milwaukee 10 amp Sawzall Corded

T00008 - Hammer - Framing

O'Hare Terminal 2 T00009 - MILWWAUKEE 7-1-4 LEFT BLADE
Construction (Jobs) CIRCULAR SAW
O'Hare Terminal 2 T0O0011 - M18™ Cordless LITHIUM-ON 3/4” SDS

Construction (Jobs) Plus Rotary Hammer Kit

Scan Date

11/4/2014
05:33 PM
117472014
05-33 PM
11/4/2014
05:33 PM
1742014
05-33 PM

Last Known Emp /
Location / Cont / Qty

O'Hare Terminal 2
Construction {Jobs)
Aisle 1 (ACME Central
Warehouse)

Bamaby, Mike

Barnaby, Mike

aty

1

Status Change
{In and Audit only)

Audit Result

G
4 rows found

The mobile Tool Tracking application must be installed on the handheld (See TTS Mobile Handheld
Application).

Before using the handheld, it must be synced with the PC application to transfer data to the handheld.
Dock the handheld to the PC and select the Sync Data Automatically button on the Download screen.
Handhelds should be synced with the PC before each use to ensure that they have the latest data.

Check in/out records can be mixed with audit records and count records on the handheld unit. When
the unit is downloaded, the records will be shown with the appropriate type displayed. The records

displayed can be limited to a specific type by clicking the appropriate Display Type button.

When a handheld unit is ready for download, select the Download button from the main screen. Dock
the handheld to the PC and select the Sync Data Automatically button. If a memory card is being used,

insert the card into the PC card reader and select the Import Data File Manually button.

If the download is successful, the system will display a successful message and the grid will be rebuilt
with the new records. If the records were downloaded successfully but there were some problems, the
system will provide a message and the problems will be documented in a log file. This file can be
viewed and printed by selecting the View Log File button.

If there are audit records stored in the temporary database table, the grid will display the existing audit
records. If the handheld contains records that are part of the existing audit, you may add its records to
the existing audit as long as the existing audit has not started the commitment process. If commit has
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been started or the handheld audit is separate from the existing audit, then the existing audit must be
completed and cleared from the database prior to uploading the new audit records.

If a checkout record is recorded on the handheld for an item that has a high priority reservation for a
different employee than the one entered on the handheld, the text will be displayed in blue. The Chk
column can be manually checked to allow the checkout of the item to the scanned employee, but this is
not recommended. Always check with the employee who originally reserved the item on the
Reservation screen before allowing the item to be checked out.

COMMIT DOWNLOAD DATA TO THE DATABASE

There could be some erroneous data in the grid. Therefore the system will only commit those records
that have the Chk column checked. This allows the user to control what records will be loaded into the
database.

The Save Changes button will save the changes in the Chk column to the temporary audit table in the
database. This does not change any tool data.

The Commit button will save the information in the audit records that have been checked to the
permanent portion of the database. The background color of the checkbox will turn yellow after those
records have been committed. An audit may be committed several times. Records that were
previously committed will be skipped. Once an audit has started the commitment process, no further
downloads will be accepted from a handheld until the audit records are cleared.

IMPORTANT! -- The Commit function changes tool data. A message will appear to alert the user to
sync all handhelds with the PC to update the reference file on the handheld.

The Clear button will remove all records from the temporary audit table in the database, making way
for new audit information. The system displays a warning message prior to clearing the records.

The Report button will print a report of the records displayed on the grid.

GigaTrak provides 90-days of telephone support for TTS from the date of purchase. GigaTrak will advise
on installation issues but the customer is responsible for network and SQL Server installation. Our
hours are 9am to 5pm central time Monday through Friday. During this time you are entitled to any
updates or new releases issued by GigaTrak. By purchasing an extended support one, two or three year
agreement, these services are extended. Onsite support is available at additional cost. Please call 262-
657-5500 Option 2 with any questions.
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